Introducing Windows 2000 Professional
What's new
No matter where you are working, your computer will be easier to use and to manage, because Microsoft Windows 2000 Professional is more compatible and more powerful than any workstation you've used before.
Easier to use
With Windows 2000 Professional, you have faster access to information, and you are able to accomplish tasks more quickly and easily.
Windows 2000 Professional makes it easier to: 

Work with files. 

Find information. 

Personalize your computing environment. 

Work on the Web. 

Work remotely. 
Easier to manage
You and your network administrators can work more efficently now, because many of the most common computer-management tasks are automated and streamlined with Windows 2000 Professional.
With Windows 2000, your workstation will be easier to: 

Set up. 

Administer. 

Support. 
More compatible
Windows 2000 Professional offers increased compatibility with different types of networks and with a wide array of legacy hardware and software.
Windows 2000 also provides:

Improved driver support. 

Increased support for new-generation hardware and multimedia technologies. 

Integration of the new Euro currency symbol. 
More powerful
For all your computing needs, Windows 2000 Professional provides: 

Industrial-strength reliability. 

The highest level of security. 

Powerful performance. 
Note

For year 2000 information regarding Microsoft products, see the Year 2000 Readiness Disclosure & Resource Center at the Microsoft Web Site (http://www.microsoft.com/). 
Using Online Registration
With online registration, you can use your modem or an Internet connection to register your copy of Windows 2000. Registration ensures that you receive product support, product update information, and other benefits. The process takes only a few minutes to complete.
Open Registration wizard.
Notes

To open Registration wizard, click Start, click Run, and then type regwiz /r. 

If you do not have a modem or an Internet connection, use the registration card included in the Windows 2000 package to register. 
The Getting Started Online Book
Novice and experienced users alike can find useful information in the Getting Started book, which is available as a printed book that comes with the Windows 2000 CD-ROM as well as online. With the online version of Getting Started, you can use your computer to read the book and to print topics.
Getting Started introduces you to Microsoft Windows 2000 Professional and helps you get the operating system up and running right away. In addition to learning how to install Windows 2000, you learn how to use the desktop, and you find out about new features. You also get information about advanced issues, such as connecting to a network, and you find answers to commonly asked questions.
See Windows 2000 Professional Getting Started.
Tips for new users
The following is a list of tasks that new users frequently perform during the first weeks running Windows 2000. 
Change your password 
Change the password that your network administrator gave you to connect to your company's network. Be sure to keep track of your new password so that your network administrator does not have to reset it for you. 
Connect to the Internet 
Establish an Internet connection. You can use your modem to connect to an Internet service provider (ISP), or you can connect to the Internet through a proxy server on your network. If you want to connect through a proxy server, you must first configure your browser to access the Internet through the proxy server. For more information, click the Help menu in Microsoft Internet Explorer. 
Find a file or folder
Search for files and folders on your local computer and on the network. 
Locate lost files 
When you are sure you saved a document file, but can't seem locate it again, this checklist of places to look will help you. 
Overview for locating lost files 
To locate lost files 
Check these locations to locate misplaced files:
The My Documents folder on the desktop

On the desktop, double-click My Documents. 
The list of recently used documents

Click Start, and then point to Documents. 
The default save location of the program you used to open or create the file
 1.
Open the program. 
 2.
On the File menu, click Save As. 

This opens the program's default save location where the file was likely saved.
Perform a search

Click Start, point to Search, and then click For Files or Folders. 
The systemroot\Profiles\user name folder
 1.
On the desktop, double-click My Computer. 
 2.
In the systemroot\Profiles folder, double-click the folder that corresponds to your user name. 

Depending on how Windows 2000 was installed on your computer, the Profiles folder may not be present.
The Documents and Settings\user name folder
 1.
On the desktop, double-click My Computer. 
 2.
Double-click the hard disk icon to display the contents of the root directory. For example, C:\ or D:\. 
 3.
In the Documents and Settings folder, double-click the folder that corresponds to your user name. 

Depending on how Windows 2000 was installed on your computer, the Documents and Settings folder may not be present.
The systemroot\system32 folder
 1.
On the desktop, double-click My Computer. 
 2.
In the systemroot\system32 folder, double-click the file or folder you want to open. 
The root directory
 1.
On the desktop, double-click My Computer. 
 2.
Double-click the hard disk icon to display the contents of the root directory. 

For example, C:\ or D:\.
The folders of the program you used to open or create the file
 1.
On the desktop, double-click My Computer. 
 2.
Double-click the hard disk icon to display the contents of the root directory. For example, C:\ or D:\. 
 3.
In the Program Files folder, double-click the file or folder you want to open. 

For example, if you created a document in Microsoft Word, the file may have been saved in one of the folders associated with Microsoft Word.
Retrieve files and documents from network folders
Access network folders easily by using the Map Network Drive wizard. 
Change the appearance of items in a folder
You can change settings so that the files in a selected folder appear as icons, as thumbnails, or as a list that includes configurable columns of detail. 
Share a folder or drive 
Allow others to access items on your computer, from a folder or from an entire drive. 
Use the Personalized Menus feature
Personalized Menus keeps your Programs menu streamlined by showing you only the programs you have used recently and removing the clutter of unused program names from the menu. 
Add a destination to the SendTo menu
You can customize your SendTo menu so that you can right-click any file or folder and send it to another location on your computer or network, or send it to open in a program such as Notepad.
Customizing your Start menu
You can customize your Start menu to add items for your favorite programs. The items are actually shortcuts.
Change the Start menu settings
You can choose items to display or remove from your Start menu. 
Turn on the Active Desktop feature
You can change your desktop to display a live page from the Internet or your intranet. When you turn on this feature, Active Desktop displays the default page of your Internet browser.
Add Web content to your desktop
You can add a picture from the Internet to your desktop, or add an item from the Active Desktop Gallery like a stock ticker, or updated news, entertainment, or weather.
Add a program to the Quick Launch bar
The Quick Launch bar lets you point and click to open Internet Explorer or Outlook Express. You can add frequently-used programs to the Quick Launch bar as well. 
Add programs to your computer
Install programs easily using Add/Remove Programs in Control Panel.
Change your computer name 
If your computer is configured with a name that no one can recognize, such as a string of unrelated letters and numbers, you may decide to give your computer a more intuitive or personal name. You can only change your computer name with your network administrator's permission. 
How to Use Help
Help overview
The Windows 2000 Help system uses HTML to format and display information. If you have an Internet connection, a jump or hyperlink no longer limits you to other topics within the Help system; you can jump to the World Wide Web for additional or updated product information.
The Help Viewer provides an integrated table of contents, an index, and a full-text search feature so you can find information easily. Book icons open to reveal topic entries and sub-books. The Help Viewer has the added benefit of allowing you to see the table of contents, index, or search results at the same time you are viewing a Help topic. This orients you within the Help system and allows you to see all of the other applicable Help topics at a glance.
The Help Viewer also includes the Favorites tab, which you can use to bookmark topics. This enables you to quickly display topics that you refer to often. The Favorites tab is only available in the main Windows Help file, which you access by clicking Start and then clicking Help.
To find a Help topic
In the Help Viewer, click one of the following tabs:
Contents tab
To browse through the table of contents, click the Contents tab. Double-click the book icons to reveal topic entries and sub-books.
Click a table of contents entry to display the corresponding topic.
Index tab
To see a list of index entries, click the Index tab, and then either type a word or scroll through the list. Topics are often indexed under more than one entry.
Double-click an index entry to display the corresponding topic.
Search tab
To locate every occurrence of a word or phrase, click the Search tab, type the word or phrase for which you want to search, and then click List Topics.
Double-click a search results entry to display the corresponding topic.
Favorites tab
To bookmark a topic, use the Contents, Index, or Search tabs to locate and then display a topic. Click the Favorites tab, and then click Add to save the topic title to the Topics list.
Double-click a bookmark in the Topics list to quickly display the topic.
Notes

If you are connected to the Internet, you can click [image: image1.png]


 on the Help toolbar to get technical support, answers to frequently asked questions, and late-breaking tips about working with Windows 2000. 

The Favorites tab is only available in the main Windows Help file, which you access by clicking Start and then clicking Help. 
To bookmark a Help topic
 1.
Use the Contents, Index, or Search tab to locate and then display the topic you want to bookmark. 
 2.
Click the Favorites tab, and then click Add. 
The Help Viewer adds the topic title to the Topics list. Later, you can return to this list and double-click the bookmark to quickly display the topic.
Notes

You can create a list of favorite/frequently visited Help topics. 

To remove a bookmark from the Topics list, click the bookmark, and then click Remove. 

If you display an externally linked topic (not part of the current Help file) and bookmark it, the Help Viewer adds a link to the topic, instead of the topic's title, to the Topics list. 

The Favorites tab is only available in the main Windows Help file, which you access by clicking Start and then clicking Help. 
To copy a Help topic
 1.
In the topic pane of the Help Viewer, right-click inside the topic you want to copy, and then click Select All. 
 2.
Inside the topic, right-click again, and then click Copy. 
 3.
This copies the topic to the Clipboard.
 4.
Open the document to which you want to copy the topic. 
 5.
Click the place in your document where you want the information to appear. 
 6.
On the Edit menu, click Paste. 
Notes

If you want to copy only part of a topic, select the part you want to copy, right-click the selection, and then click Copy. 

Words that are links to other topics and step numbers are not copied to the Clipboard. 
To print a Help topic

Right-click the topic you want to print, and then click Print. 
Notes

To print a pop-up topic, right-click inside the pop-up window, and then click Print Topic. 

To print all topics within a book, on the Contents tab, select the book. On the Help toolbar, click Options, click Print, and then click Print the selected heading and all subtopics. 
To display Help for an MS-DOS command
 1.
Open a command prompt window. 
 2.
At the command prompt, type the name of the command you want help on, followed by /?. 

For example, type chdir /? to get Help on the chdir command.
Notes

To open a Command Prompt window, click Start, point to Programs, point to Accessories, and then click Command Prompt. 

To display Help one screen at a time, type the command followed by | more. For example, type dir /? | more for Help on the dir command. 
To get the latest documentation on the Web for Windows 2000 Professional or Windows 2000 Server

To view the latest documentation for Windows 2000 Professional, go to the Windows Home Pages at the Microsoft Web Site (http://www.microsoft.com/). To view the latest documentation for Windows 2000 Server, go to the Windows Home Pages at the Microsoft Web Site (http://www.microsoft.com/). 

To download the latest documentation to your computer, go to Windows Update at the Microsoft Web Site (http://www.microsoft.com/). 
Notes

Windows Home Pages are an extensive collection of useful Windows resources, information, and services at the Microsoft Web site. 

Windows Update is a catalog of items such as drivers, patches, the latest help files, and Internet products that you can download to keep your computer up to date. You must be logged on as an administrator or a member of the Administators group in order to access the Product Updates section of Windows Update for downloading help files. 
To get Help in a dialog box

Click the [image: image2.png]


 in the title bar of the dialog box, and then click an item in the dialog box. 
Notes

You can also get Help on an item by right-clicking the item, and then clicking What's This?. 

To print or copy the information in a pop-up window, right-click inside the pop-up window, and then click Print Topic or Copy. 

To close the pop-up window, click inside it. 

If the dialog box does not have a [image: image3.png]


 button, click Help, or press F1. 
Help Viewer keyboard shortcuts
If your mouse is unavailable or if you prefer using your keyboard, you can use the following keyboard commands to navigate within the Help Viewer.
To expand the headings below using the keyboard, press F6 to switch from the Help navigation pane to the topic pane. Press TAB to select the desired keyboard shortcut heading, and then press ENTER to expand the listing.
Help Viewer keyboard shortcuts
Press
To
ALT+SPACEBAR
Display the system menu.
SHIFT+F10
Display the Help Viewer shortcut menu.
ALT+TAB
Switch between the Help Viewer and other open windows.
ALT+O
Display the Options menu.
ALT+O, and then press T
Hide or show the navigation pane.
CTRL+TAB
Switch to the next tab in the navigation pane.
CTRL+SHIFT+TAB
Switch to the previous tab in the navigation pane.
UP ARROW
Move up one topic in the table of contents, index, or search results list.
DOWN ARROW
Move down one topic in the table of contents, index, or search results list.
PAGE UP
Move up one page in the table of contents, index, or search results list.
PAGE DOWN
Move down one page in the table of contents, index, or search results list.
F6
Switch focus between the navigation pane and the topic pane.
ALT+O, and then press R
Refresh the topic that appears in the topic pane.
UP ARROW or DOWN ARROW
Scroll through a topic.
CTRL+HOME
Move to the beginning of a topic.
CTRL+END
Move to the end of a topic.
CTRL+A
Highlight all text in the topic pane.
ALT+O, and then press P
Print a topic.
ALT+O, and then press B
Move back to the previously viewed topic.
ALT+O, and then press F
Move forward to the next (previously viewed) topic.
ALT+F4
Close the Help Viewer.
Contents tab keyboard shortcuts
Press
To
ALT+C
Display the Contents tab.
RIGHT ARROW
Open a book.
LEFT ARROW
Close a book.
BACKSPACE
Return to the previous open book.
UP ARROW or DOWN ARROW
Select a topic.
ENTER
Display the selected topic.
Index tab keyboard shortcuts
Press
To
ALT+N
Display the Index tab.
UP ARROW or DOWN ARROW
Select a keyword in the list.
ALT+D or ENTER
Display the associated topic.
Search tab keyboard shortcuts
Press
To
ALT+S
Display the Search tab.
ALT+L
Start a search.
ALT+D or ENTER
Display the selected topic.
Favorites tab keyboard shortcuts
Press
To
ALT+I
Display the Favorites tab.
ALT+A
Add a topic to the Topics list.
ALT+P
Select a topic in the Topics list.
ALT+R
Remove a topic from the Topics list.
ALT+D
Display a topic from the Topics list.
